User’s Manual

Tax Year 2010

Supplement: Corporations (1120)
Copyright

The 2010 Drake Software Manual Supplement: Corporations, Drake Tax Software, and any other related materials are copyrighted material. All rights are reserved by Drake Enterprises, LTD, including all ownership rights. This document, associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the material in this document in an unaltered form only for your personal, non-commercial use or for non-commercial use within your organization. Copyright, trademark, and other proprietary notices may not be removed.

© 2010 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for damages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake Enterprises, LTD.

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies.
# Table of Contents

**What's New in Drake for Corporations** .................................................. 1  
Data Entry and Calculation ................................................................. 1  
Screens and Forms .................................................................................. 2  
Electronic Filing Features ................................................................. 2  

**Before You Start** .................................................................................. 3  
Updating a Prior-Year Return in Drake ................................................. 3  
Converting from Another Return Type ............................................... 3  
Filing Form 1120-C or 1120-H ............................................................. 3  

**Header Information** ........................................................................... 4  
Name and Address .................................................................................... 4  
Tax Year ................................................................................................. 4  
Boxes A through E ................................................................................. 5  

**Income and Deductions** .................................................................... 5  
Gross Receipts ......................................................................................... 5  
Cost of Goods Sold (Schedule A) ........................................................ 5  
Dividends (Schedule C) ....................................................................... 6  
Interest .................................................................................................. 6  
Rents and Royalties ............................................................................. 7  
Capital Gains .......................................................................................... 7  
Ordinary Gains and Losses ............................................................... 7  
Other Income (Loss) ............................................................................ 7  
Compensation of Officers (Schedule E). ............................................. 8  
Salaries and Wages ............................................................................. 8  
Repairs and Maintenance .................................................................. 8  
Bad Debts .............................................................................................. 9  
Rents ...................................................................................................... 9  
Taxes and Licenses ............................................................................... 9  
Interest .................................................................................................. 9  
Charitable Contributions .................................................................. 9  
Depreciation ......................................................................................... 10  
Depletion ............................................................................................... 10  
Advertising .......................................................................................... 10  
Pension and Profit-Sharing ................................................................. 10  
Domestic Production Activities ........................................................... 10  
Other Deductions ............................................................................... 11  
NOL Carrybacks and Carryforwards .................................................. 11  

**Tax, Refundable Credits, and Payments** ............................................. 11  
Total Tax ................................................................................................. 11  
Estimated Taxes and Applied Refunds ............................................... 12  

**Direct Deposit of Refunds** ................................................................. 12
Electronic Funds Withdrawal (Direct Debit) .................................................. 13
Program Defaults and Overrides ................................................................. 13
Required Information .................................................................................. 13
Withdrawal from Multiple Accounts ......................................................... 13
Filing an Extension ...................................................................................... 14
Signing the Return ...................................................................................... 14
Amending a Return .................................................................................... 15
Schedule K .................................................................................................. 16
Schedule K, Line 3 ....................................................................................... 16
Schedule K, Line 4 ....................................................................................... 16
Schedule K, Line 5 ....................................................................................... 17
Schedule K, Line 7 ....................................................................................... 17
Schedule K, Line 13 .................................................................................... 18
State-Specific Information ......................................................................... 18
Resident State ............................................................................................. 18
Other States ................................................................................................. 18
Contact Information .................................................................................... 19
Other Information and Overrides ............................................................... 19
Schedule L (Balance Sheet per Books) ....................................................... 19
Flow of Information .................................................................................... 19
The SCH2 Screen ....................................................................................... 20
Autobalance ................................................................................................. 21
Schedules M-1 and M-3 (Reconciliation of Income per Books) .................. 21
Schedule M-1 ............................................................................................... 21
Schedule M-3 ............................................................................................... 22
Schedule M-2 (Unappropriated Retained Earnings) .................................... 23
M-2 Troubleshooting .................................................................................. 23
Schedule O (Controlled Group Information) .............................................. 24
AMT Adjustments and Other Items ............................................................ 24
Types of Controlled Groups ....................................................................... 24
Line 5, Apportionment Plan Status .............................................................. 25
Credits and Adjustments .......................................................................... 25
Adjusting Charitable Contributions/NOL. ............................................... 25
Making Changes on the Fly ....................................................................... 26
Suppressing/Forcing Documents ............................................................... 26
Calculation and Other Options .................................................................. 26
Overriding Other Setup Options ............................................................... 27
Guide to Overrides and Adjustments ......................................................... 27
Electronic Filing .......................................................................................... 28
Common Error Codes ................................................................................. 28
Special Types of Returns .......................................................... 29
  Electing a 52-53-Week Year (Initial Return) ........................................ 29
  Inactive Returns ........................................................................ 30

Binary Attachments ........................................................................ 30
  The PDF Attachment Process .......................................................... 30
  Printing Generated Documents ......................................................... 32

Importing Trial Balance Information .................................................. 33
  Preparing to Use Trial Balance Import ............................................... 33
  Preparing Financial Data for Import .................................................. 34
  Entering Financial Data .................................................................. 36
  Saving a File ................................................................................. 38
  Importing Data into a Return ............................................................. 38
  Special Conditions .......................................................................... 39

Appendix: Trial Balance Import .......................................................... A-1

Index ........................................................................................... vii
Corporations (1120)

The basics of data entry for a corporation (1120, 1120-C, 1120-H) return are the same as for a 1040 return. Field- and screen-level help, shortcut keys, and navigation throughout data entry all function as they do in the 1040 program. See the Drake Software User's Manual: Tax Year 2010 for the basics of using the program.

What’s New in Drake for Corporations

Drake programs its tax software according to the latest IRS rules and regulations. The 2010 program reflects all changes to credits and deductions, including discontinuations. For details on the new regulations for the 2010 tax year, see the IRS instructions for Form 1120.

Data Entry and Calculation

This year’s changes and enhancements to calculations are summarized below:

- **Improved Calculation Results Window** — The Calculation Results window now features more EF message links. (An EF message link takes you directly to the screen that is causing the EF message.)

- **Foreign Ownership Capabilities** — Screens G and K have been expanded to allow input of foreign owners without an EIN. In addition, returns with foreign ownership information on schedules G and K are now eligible for e-filing.

- **Multiple Forms 8027 Available** — Returns can now include multiple instances of Form 8027, Employer’s Annual Information Return of Tip Income & Allocated Tips.

- **Depreciation on Installment Sales and Like-Kind Exchanges** — For a sold item on the 4562 (Depreciation Detail) screen, three new options are available in the Property type drop list (located in the If sold section of the screen). Selecting one of these options (listed below) prevents the program from automatically carrying the sale information to Form 4797.
  - IN — Installment sale, section 1245 property (Form 6252)
  - IS — Installment sale, section 1250 property (Form 6252)
  - LK — Like-kind exchange (Form 8824)

- **Form 1120-C, Cooperative Associations** — The 20C screen now allows entry of non-patronage NOL carryforwards from prior years.
• **Section 179 Expensing for Qualified Real Property** — In accordance with the Small Business Jobs Act of 2010, a taxpayer may elect, under section 179, to expense up to $250,000 of the cost of qualifying real property placed in service during the taxable year. In Drake, this election is made on the 4562 screen.

### Screens and Forms

Listed below are some of the changes to screens and forms in this year’s 1120 program:

- **Screens G1 and G2** — In the 2009 program, screen G was used for Schedule G, Voting Stock Ownership. In the 2010 program, this screen has been broken out into screens G1 (Schedule G, Part I) and G2 (Schedule G, Part II).
- **Screens K5A and K 5B** — Screens K5A and K5B have been added for completing Schedule K, lines 5a and 5b, respectively. To access either of these screens, click the applicable link from screen K, or enter the screen code into the selector field and press ENTER.
- **Screen L** — The L screen and L2 screens from previous years have been consolidated into one screen for easier data entry. Links to the SCH2 screen are provided for those items requiring a subsidiary schedule.
- **CCOM screen** — Similar to the COMP screen, the CCOM screen compares data from the current return with data from the two previous years’ returns for Form 1120-C.
- **Form 8866** — Form 8866, Interest Computation Under the Look-Back Method for Property Depreciated Under the Income Forecast Method, has been added to the 1120 package.

### Electronic Filing Features

This year’s e-filing changes for the corporate package are listed below:

- **Amended Returns EF Eligible** — Form 1120X, Amended U.S. Corporation Income Tax Return, is now eligible for e-filing. See “Amending a Return” on page 15 for information on e-filing Form 1120X.
- **Foreign Ownership Information** — Returns with foreign ownership information on schedules G and K are now eligible for e-filing.
- **More EF “Trapping” For Business Returns** — New programming will help the software catch more errors in a return before a return can be e-filed and then rejected by the IRS.
- **EF Messages and Notes** — Many of the EF messages and notes pages have been rewritten for improved clarity and to better help with trouble-shooting issues in business returns.
- **EF Messages for Accepted Returns** — An EF messages is now produced when a return is calculated that has already been e-filed and accepted.
Before You Start

Actions you might need to take before starting a 1120 return in Drake include:

- Updating a prior-year return (if you prepared the tax return last year)
- Changing a return from another type of return to an 1120, if the corporation has made such a change in the last year

Updating a Prior-Year Return in Drake

A prior-year return can be updated in three ways:

- With all other returns in the program using Last Year Data > Update 2009 to 2010 (not recommended)
- As a single return (updated one at a time) using Last Year Data > Update 2009 to 2010 (recommended)
- When you open a return for the first time in the 2010 program and are prompted to update it

When you update an 1120 return that was marked “final” the previous year, the program informs you that the return was marked final before prompting you to proceed.

Converting from Another Return Type

If the corporation is electing to become an 1120 corporation after existing as another type of entity (S corporation, partnership, etc.), it is necessary to indicate this in the program.

To change from another type of entity to an 1120 corporation in the program:

1. From the Home window, select Tools > File Maintenance > Change File Type.
2. Enter the EIN of the entity and click OK.
3. Select the new return type.
4. Click OK to save the change.

Filing Form 1120-C or 1120-H

The CCOM screen has been added to allow comparison of the current-year 1120-C return with those from the two previous years. This screen is similar to the COMP screen for 1120 returns and the HCOM screen for 1120-H returns.

No preliminary steps are required for Forms 1120-C or 1120-H. Use the same screens you might for an 1120 return, but include one of the following screens in addition:

- 20C — For Form 1120-C, U.S. Income Tax Return for Cooperative Associations
- H — For Form 1120-H, U.S. Income Tax Return for Homeowners Associations
If one of these screens contains data, the program automatically produces the type of return indicated. For example, if a deduction is entered on screen 20C, an 1120-C return will be produced.

**Tip**

Is Form 1120-C or 1120-H being produced in error? Check the corresponding screen (20C or H) for data entered. To delete a screen, open the screen to delete and press CTRL+D.

**Header Information**

Screen 1 contains fields for the general information that is printed in the top section of page 1 of Form 1120 (or Form 1120-C or 1120-H, as applicable).

**Name and Address**

Use screen 1 to enter the corporation name and address for Form 1120. For state purposes only, if the corporation has an alternate address (such as a P.O. box), you can enter that address on screen 2, in the Address Line 2 field at the bottom of the screen.

**Tax Year**

The software uses the calendar year as the default tax period for all corporate returns; no date entries are required on screen 1 for a December 31 tax year end.

**Fiscal and Calendar Years**

If the corporation uses a fiscal year (where the year begins in the current calendar year and ends in the next), specify the beginning and ending dates in the If not calendar year section in the lower-left corner of screen 1.

**Note**

The program adjusts calculations for depreciation and for gains and losses on sales of assets based on the entity's tax year.

For information on filing with a 52-53-week year, see “Electing a 52-53–Week Year (Initial Return)” on page 29.

**Short-Year Returns**

An entity may have a short-year return if changing accounting periods with IRS approval (Form 3115), or if this is its first or last year in business and the tax year is not a full year.

To indicate a short-year return, use the fiscal year date fields on screen 1 to indicate the beginning and ending dates for the current year.

If filing a short-year return (other than an initial or final return), you have to provide an explanation. To do so, go to the ELEC screen and select an explanation from the Other short year options/elections drop list. Your explanation will be displayed at the top of the first page of the tax return. If you do not select an explanation, an EF message will be generated with the return, and the return cannot be e-filed.
For more information on short-year explanations, see IRS Pub. 4163. The program may not correctly calculate depreciation, gains, or losses for a short-year return. Depreciation for a short-year return can be entered on screen 4562 and/or screens 6, 7, 8, and 9.

**Boxes A through E**

Use screen 1 to enter most information for boxes A through E (top of Form 1120). Note that boxes A-4 (“Schedule M-3 attached”) and D (“Total assets”) are completed automatically by the program based on data entered elsewhere.

**NEW FOR 2010**

Box 1a (“Consolidated return”) is automatically marked if there are entries on screen 851 (Form 851, Affiliations Schedule). Box 2 (“Personal holding company”) is automatically marked if there are entries on screen PH (Schedule PH, U.S. Personal Holding Company (PHC) Tax).

**Income and Deductions**

Income and deductions are entered primarily on screens 3, INC (Other Income), DED (Other Deductions), and TAX (Taxes and Licenses).

**Gross Receipts**

Enter gross receipts (Form 1120, line 1a) and returns and allowances (Form 1120, line 1b) on lines 1a and 1b of screen 3. Exclude any amounts that are to be reported on lines 4 through 10 of Form 1120.

**Cost of Goods Sold (Schedule A)**

For cost of goods sold (COGS), complete screen A (Schedule A, Cost of Goods Sold).

**NOTE**

On screen A, items 9a through 9f are direct-entry fields and follow the format of IRS Schedule A. For more information on completing these fields, press F1 or consult the IRS instructions.

**Inventory**

Inventory amounts entered on lines 1 and 7 of Schedule A automatically flow to Schedule L, line 3 (“Inventories”).

***NOTES***

Lines 1 and 7 of screen A are adjustment fields. Amounts entered in these fields adjust (add to or subtract from) any amount being carried from the F screen (Form 1040, Schedule F, Profit or Loss from Farming) to line 2 of Form 1120.

The fields on screen L (Schedule L - Balance Sheet - Assets) for line 3 “Inventories” are override fields. Anything entered in these fields overrides (replaces) the data entered for inventory on screen A.
Line 5, Other Costs

Line 5, “Other costs,” is designated for any applicable costs not entered on lines 2 through 4 (purchases, cost of labor, and additional section 263A costs). In Drake, two data-entry fields are used to complete line 5: one for other costs excluding depreciation, and one for depreciation (Figure 1).

![Figure 1: Screen A (Schedule A), line 5]

In the Depreciation field, enter any depreciation that relates to the cost of goods sold (unless the amount is flowing from the 4562 Detail screen with COGS selected from the For drop list). (Note that this field is an override field; an entry here overrides calculations from the 4562 screen.) Amounts entered in this field automatically adjust the total depreciation that is carried to page 1 of Form 1120. For Other costs - excluding depreciation, use a CTRL+W worksheet. The depreciation amount is included on the statement for other costs and should not be included in the Other Costs worksheet.

Importing Trial Balance to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on page 33), enter depreciation amounts directly into the appropriate fields on the trial balance worksheet, not in the fields in data entry. When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Schedule A and is calculated accordingly.

Dividends (Schedule C)

Enter dividends and special deductions on screen C (Schedule C). The Dividends Received Deduction Worksheet (WK_DRD) is generated from data entered in these fields. The result of the WK_DRD is carried to Schedule C of the return. The total from Schedule C, line 19, column A, is carried to Form 1120, line 4 (“Dividends”), and the total from Schedule C, line 20, column C, is carried to Form 1120, line 29b (“Special deductions”),

**NOTE**

If the corporation is filing a consolidated return, do not enter non-included dividends here or anywhere else in the program.

Interest

Line 5 is for interest income, which is entered on screen 3, line 5. Note that the line 5 field is an adjustment field; an amount entered there is combined with the interest amount, if any, entered on screen 6252 (Form 6252, Installment Sale Income).

Enter tax-exempt interest income at the bottom of the INC screen. This amount flows, as applicable, to Schedule K, line 9, and to Schedule M-1, line 7. Override fields are available on screens K and M1 if necessary to override the INC screen amount.
Rents and Royalties

Enter gross rents and gross royalties using the direct-entry fields on screen 3. Note that passive activity loss rules may be applied to rental activities held by a closely held corporation or a personal service corporation.

NOTE

The Rents field is an adjustment field. An amount entered here is combined with the amount, if any, entered in the Rent fields on screen F.

Capital Gains

Use screen D (Schedule D) to enter capital gains and losses. The net gain from screen D is carried to line 8 of Form 1120. (Any net capital loss is carried to the ATT_D attachment to offset future gains.)

NOTE


Ordinary Gains and Losses

The amount generated on line 9 flows from screen 4797. Amounts can also flow from screen 4562 to Form 4797 (making screen 4797 entries unnecessary), but only if screen 4562 shows assets sold, date, and property type.

Other Income (Loss)

Use the INC screen to enter amounts for the “Other income” line of the main form. Specific INC screen entries are displayed on attached statements in View mode of the return.

For Form 1120, calculated amounts from the following screens also flow automatically to the “Other income” line (line 10):

- Screen 6478 (Form 6478, Alcohol and Cellulosic Biofuel Fuels Credit)
- Screen 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields for other income on the INC screen include:

- Amount of credit for tax on fuels
- Interest income on receivables
- Ordinary income from partnerships (must include partnership name and EIN; see note following this list) (Detail worksheet is required.)
- Recoveries of bad debts
- Section 481 adjustments
- State tax refund
- Income from insurance proceeds
- Other (itemize) (Detail worksheet is required.)
Compensation of Officers (Schedule E)

Schedule E is not generated automatically with the return unless it is required—in other words, unless total receipts (line 1a, plus lines 4 through 10) on Form 1120 are $500,000 or more. To force the software to print the Schedule E, from the PRNT screen, select Force Schedule E.

Entering Comp Data

Use screen E to enter officer information and compensation amounts. Press PAGE DOWN to enter additional officers. Screen E totals are calculated and carried to line 12 of Form 1120.

The total of officer compensation can be entered in the override field on screen 3 (generally used when Schedule E is not required). An entry in that field overrides any calculations from screen E, changing lines 12 and 27 of the 1120 but not Schedule E.

Screen E Check Boxes

Screen E has two check boxes: Signs return, and Books in care of. Mark the applicable box on the screen that identifies the officer who either signs the federal or state paper returns, or is the contact person for the books (state return only).

Ownership & Participation

The Ownership and Participation fields on screen E are required. Fields are as follows:

- **Total** — Enter the officer’s ownership percentage.
- **Common** — Enter the percentage of common stock owned by the officer.
- **Preferred** — Enter the percentage of preferred stock owned by the officer.
- **Time** — Enter the percentage of time the officer devotes to the corporation.

Enter percentage amounts in whole numbers. For example, enter 40 for 40%.

Salaries and Wages

Use screen 3 to enter salaries and wages paid. Note that the screen 3 amount is reduced by the amount, if any, of credit from Forms 5884, 8844, and 8845. (See the wages and salaries attachment (ATT_CSW) for more information.)

The Salaries and wages field on screen 3 should not include compensation of officers. Enter officer compensation data on screen E or as Officer Compensation on screen 3, line 12.

Repairs and Maintenance

Enter repair and maintenance costs on screen 3. An amount entered here is combined with the amount, if any, entered in the Repairs and maintenance field on screen F.
Bad Debts

Use the **Bad debts** field on screen 3 to enter the total debts that became worthless in whole or in part during the year, but only to the extent that such debts related to a trade or business activity.

**Note**
Enter deductible non-business bad debts as a short-term capital loss on Schedule D (Form 1120).
Cash method corporations cannot take a bad debt as a deduction unless the amount was previously included in income.

Rents

Use screen 3 to enter rent paid on business property used for a trade or business activity. If the partnership rented or leased a vehicle, enter the total annual rent or lease expense incurred in the trade or business activity of the entity, and then complete Part V of the 4562 (screens 8 and 9).

Taxes and Licenses

Enter tax and license amounts on the **TAX** screen. Amounts are combined and the sum generated on Form 1120, line 17 (“Taxes and licenses”). Note that credit from Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips) adjusts the line 17 amount.

**Note**
These amounts also appear on the Taxes and Licenses Attachment (ATT_CTL), referred to on line 17 with an “ATT_CTL” reference. To keep the notification from appearing, go to the **PRNT** screen and select Suppress printing form and attachment references.
State tax amounts (income tax and franchise tax) entered on the **ES** (Estimated Taxes) screen are carried to the tax computation (ATT_TAX) worksheet. The state tax amount carried from the **ES** screen may differ depending on which method of accounting (cash or accrual) is used.

Interest

Enter interest expense on line 18 of screen 3. Note that the **Interest expense** field is an adjustment field. Any amount entered here is combined with the amount, if any, entered in the **Interest** fields on screen F.

Charitable Contributions

Screen 3 provides two fields for entering data for line 19, Charitable contributions.

![Charitable contribution lines on screen 3](image_url)
• **Contributions** — Enter the gross amount of contributions for the year that are subject to the 10% limit on deduction.

• **100% farm-related qualified conservation contributions** — Enter the gross amount of contributions for the year that are not subject to the 10% limit. These contributions have a carryover period of 15 years; see IRS instructions for details.

The program calculates the contributions allowed and determines carryover capability for amounts entered in both fields for line 19 and reflects the applicable amount on Form 1120. (Refer to the contribution limitation/carryover worksheet (WK_CNTRB) for calculation of allowed amount.) Contribution carryovers from prior years are entered on the **LOSS** screen.

### Depreciation

Enter depreciation on the **4562** screen. Select a form from the **For** drop list (Figure 3) to associate the depreciable item with the correct form or activity. Data from the **4562** screens is calculated and carried to Form 1120 and to the selected schedules or forms.

![Figure 3: Selecting Form 1120 from the 4562 screen For drop list](image)

**NOTE**

For more on the **For** drop list in Drake, see “Associating One Screen with Another,” in the *Drake Software User’s Manual: Tax Year 2010*

### Depletion

Enter depletion deductions on screen **3**. See Form 1120 instructions and Pub. 535 for more information on depletion.

### Advertising

Enter advertising expenses on screen **3**.

### Pension and Profit-Sharing

The software reduces the expense based on the credit amount calculated from Form 8881, Credit for Small Employer Pension Plan Startup Costs.

### Domestic Production Activities

Use screen **8903** to complete Form 8903, Domestic Production Activities Deduction (DPAD). The calculated total of screen **8903** flows to line 25 of Form 1120.
The DPAD is not allowed on returns with a net operating loss (NOL) for the current year. It also cannot be used to create a current-year loss.

Other Deductions

Enter all other deductions on the DED screen. The program calculates these amounts and incorporates the total into line 26 ("Other deductions") of Form 1120. The following deductions, credits, adjustments, and exclusions also flow to line 26:

- Amortization from Form 4562
- Credit from Form 8820, Orphan Drug Credit
- Exclusion from Form 8873, Extraterritorial Income Exclusion
- Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Drake automatically calculates meals and entertainment limitations.

A detail (CTRL+W) worksheet is required for the "Other (itemize)" field (the last field on the DED screen). The program automatically generates a worksheet if an entry is made here, or in any other field where a worksheet is required by the IRS.

NOL Carrybacks and Carryforwards

Enter NOL carrybacks from future years to the current year on line 29a of screen 3. To enter multiple carryback amounts, use a detail (CTRL+W) worksheet.

Use the LOSS screen to enter NOL carryforwards, capital losses, and contribution carryforwards from prior years. Use screen 3 to enter current-year carrybacks to prior years.

Tax, Refundable Credits, and Payments

Screen 4 has fields for completing the “Tax and Payments” section of Form 1120. Note that some fields are overrides. Press F1 to view more information on a field.

Total Tax

For corporations that belong to a controlled group, complete all applicable fields on screen J (Schedule J, Tax Computation). If allocating income to the various brackets on the J screen, you must enter 0 (zero) in the fields of the brackets to which no income is allocated.

The total tax from Schedule J is calculated and carried to line 31 of Form 1120.

Controlled groups are also required to complete Schedule O. Use the O screen in Drake to complete Schedule O. See “Schedule O (Controlled Group Information)” on page 24.
Estimated Taxes and Applied Refunds

Enter estimated corporate taxes paid on screen ES. If necessary, use screen W to override 2010 estimated taxes paid and apply any overpayments from 2010 to 2011.

**NOTE**

Estimate vouchers are not used in federal corporate tax returns.

**Quick Refund**

To file Form 4466, Corporation Application for Quick Refund of Overpayment of Estimated Tax, go to the PRNT screen and mark the **Calculate Form 4466** box. This is the only entry necessary to produce the form.

**Underpayment**

Use screen **2220** to enter information for Form 2220, Underpayment of Estimated Tax by Corporations. Note that the **2220** screen in Drake consists of two screens. Press PAGE UP and PAGE DOWN to move from screen to screen.

**IMPORTANT**

The program retains the underpayment and penalty rates as of 12/31 of the calendar year. If a corporation has a fiscal year end, you must enter the effective rates manually.

**State Estimates**

Enter 2010 estimates and 2011 overpayments for state returns on the ES screen. For the federal return, to override 2010 estimates and apply overpayments to 2011, use screen W.

**Direct Deposit of Refunds**

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submitted with an e-filed return in order for a corporate refund to be direct-deposited. To access this form in Drake, go to the DD screen, accessible from the General tab.

When filling out the DD screen:

- If the federal refund is to go to the account listed, select **Yes** for the Federal Account selection; otherwise, select **No**. (Default is **Yes**.)
- If a state refund is to go to the account listed, select the state abbreviation from the State/City selection drop list.
- Enter the name of the financial institution, the routing number (RTN), the account number, and the type of account (Checking or Savings).
- Re-enter the routing number, account number, and type of account to verify. (Figure 4)

![Figure 4: Federal section of DD screen (also 8050 screen)](image_url)
If receiving refunds from different state tax authorities, use the **State Account** boxes on the **DD** screen to indicate where other state refunds should be deposited.

**Electronic Funds Withdrawal (Direct Debit)**

Use the **PMT** screen, accessible from the **General** tab, to indicate that the balance due for an e-filed return be withdrawn (direct-debited) from an account.

**Program Defaults and Overrides**

By default, the program indicates that the entire balance due (line 34, “Amount owed,” of Form 1120) is to be withdrawn on the return due date. To indicate otherwise, complete the **Requested payment date** override fields (see Figure 5) for the applicable payment. If the return is e-filed on or before the due date, the requested payment date cannot be later than the due date. If the return is transmitted after the due date, the requested payment date cannot be later than the date the return is transmitted.

**Required Information**

A **Withdrawal selection** (item 1 in Figure 5) is required if the program is to direct tax authorities to withdraw funds from the corporate bank account.

![Withdrawal selection](image)

**Figure 5**: Required fields on **PMT** screen: withdrawal selection (1); account information (2); specified return (3)

The name of the financial institution, RTN, account number, and account type are required. As with the **DD** screen, the **RTN**, **Account number**, and **Type of account** data must be entered twice (item 2 in Figure 5).

Finally, the **PMT** screen must indicate the return to which the payment data applies (item 3 in Figure 5). Mark the box of the applicable return type: **1120** or **7004**.

**Withdrawal from Multiple Accounts**

Only one account can be designated for direct debit of funds for payment of federal or state taxes. To have state amounts withdrawn from an account other than the account
indicated for federal payments, complete the fields in the State Account sections of the PMT screen.

**Note**

Neither the federal nor the state balance due can be paid from more than one account.

---

**Filing an Extension**

Calendar year returns are due on March 15, 2011. By filing Form 7004, a corporation can extend the deadline six months to September 15. Fiscal year returns are due on the 15th day of the third month after the end of the corporation’s year. The 7004 extends the deadline six months.

**Note**

An 1120 return is due no later than eight and a half months after the close of the corporation’s tax year.

Use one of the following options to file an extension for an 1120, 1120-C, or 1120-H:

- Go to the 7004 screen in Drake and select Generate an extension. Complete any other applicable fields on the screen.
- Go to the PRNT screen and select Prepare Form 7004 extension based on screen 1 info.

---

**Signing the Return**

Electronic (PIN) signatures are required for e-filed returns. If e-filing a return, complete all fields on the PIN screen. A return cannot be e-filed if the PIN screen fields, including the title and signature (name) of the officer signing the return, are not completed.

An 1120 return must be signed and dated by one of the following individuals:

- The corporation’s president, vice president, treasurer, assistant treasurer, or chief accounting officer
- Any other corporate officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required information and sign the return in the space provided. If it is prepared by an employee or officer of the corporation, select NONE in the Firm # and Preparer # drop lists on screen 1.

To have the preparer’s name and address information displayed on the printed return:

- If the return preparer and ERO (entered in Setup > ERO) are the same:
  - Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signature box is marked for the preparer.
  - Complete the PIN screen for the return.
- If the return preparer and ERO are not the same:
Amending a Return

The program can automatically fill the **1120X** screen for Form 1120X, Amended U.S. Corporation Income Tax Return.

When you amend a return in Drake, the amended information replaces the original in the data file. Before amending a return, you should archive the original to avoid losing previously submitted data. For more information on archiving returns, see “Archive Manager” in Chapter 6, “Return Results,” of the *Drake Software User’s Manual: Tax Year 2010*.

**Returns Previously Prepared in Drake**

From the **Data Entry Menu** of an 1120 return, enter an \( \times \) in the selector field and press ENTER. (Screen X is also accessible from the first **Other Forms** tab.) At the prompt, select **Yes** to automatically fill the screen with data from the original return (that is, the return as originally entered in Drake). If the corporation’s name and address information has changed, enter the new information on screen X. Make all other necessary changes to the **regular data entry screens**. When you go to View mode, the program calculates the amended return.

**New Returns**

To amend a return not previously prepared in Drake, create an 1120 return in Drake and open screen X. Complete the applicable fields on this screen, and then enter the amended data in the appropriate other screens, as described in the example below.

Example: An 1120 return was filed using a different tax software, but gross rental income was not reported on line 6. To amend the return:

1. From the **Data Entry Menu** of an 1120 return, open screen X.
2. Complete all applicable fields on screen X.
4. Enter the amount of unreported income on line 6.
5. Calculate and view the return. Note the adjustments made on the Form 1120X.

**E-filing an Amended Return**

To add Form 1120X to the queue for e-filing, go to the **EF** screen for the return and mark the **1120-X** box. For detailed instructions on e-filing the returns in the queue, see Chapter 7, “E-filing,” in the *Drake Software User’s Manual: Tax Year 2010*.
Schedule K

Use screen K to enter data for Schedule K, Other Information. Screen K should also be used for Schedule K of Form 1120-C. Detailed here are some specific areas that might need your attention.

NEW FOR 2010

Returns with foreign ownership information on Schedules G and K are now eligible for e-filing.

Schedule K, Line 3

On line 3 (line 5 for 1120-C), enter the EIN and name of the parent corporation if the corporation is a subsidiary in an affiliated group or a parent-subsidiary controlled group.

Be aware of the following guidelines from the IRS:

- “If the corporation is an ‘excluded member’ of a controlled group (see section 1563(b)(2)), it is still considered a member of a controlled group for this purpose.
- “An affiliated group is one or more chains of includible corporations (section 1504(a)) connected through stock ownership with a common parent corporation. The common parent must be an includible corporation and the following requirements must be met.
- “The common parent must own directly stock that represents at least 80% of the total voting power and at least 80% of the total value of the stock of at least one of the other includible corporations.
- “Stock that represents at least 80% of the total voting power and at least 80% of the total value of the stock of each of the other corporations (except for the common parent) must be owned directly by one or more of the other includible corporations.
- “For this purpose, the term ‘stock’ generally does not include any stock that (a) is nonvoting, (b) is nonconvertible, (c) is limited and preferred as to dividends and does not participate significantly in corporate growth, and (d) has redemption and liquidation rights that do not exceed the issue price of the stock (except for a reasonable redemption or liquidation premium). See section 1504(a)(4). See section 1563(d)(1) for the definition of stock for purposes of determining stock ownership.”

Schedule K, Line 4

If a corporation, partnership, trust, individual, or estate owned, directly or indirectly, 20 percent or more, or owned, directly or indirectly, 50 percent or more of the total
voting power of all classes of the corporation’s stock entitled to vote, enter the applicable data on Schedule G.

NEW FOR 2010 Use screens G1 and G2 for Schedule G. These screens can be accessed from the Data Entry Menu or from the Schedule K screen (by clicking the applicable link or pressing PAGE DOWN).

If the stock is owned by a corporation, partnership, or trust, enter on screen G1 the name and EIN of the entity, the type of entity (corporation, partnership, or trust), the country of the entity’s organization, and the percentage of stock the entity owns.

If the stock is owned by an individual or estate, enter on screen G2 the name and ID number of the individual or estate, country of citizenship, and percentage of stock owned. Mark the check box if this stock is owned by an individual.

Use the CTRL+PAGE DOWN function to open additional (blank) G1 or G2 screens. For more information on line 4 of Schedule K, see the IRS instructions.

Schedule K, Line 5

If the corporation owned stock in other corporations or partnerships, or the beneficial interest in a trust, enter the information Schedule K.

NEW FOR 2010 Use screens K5A and K5B for Schedule K, line 5a and Schedule K, line 5b, respectively. These screens can be accessed from the Data Entry Menu or from the Schedule K screen (by clicking the applicable link or pressing PAGE DOWN).

Use the CTRL+PAGE DOWN function to open additional (blank) K5A or K5B screens. For more information on line 5 of Schedule K, see the IRS instructions.

Schedule K, Line 7

Enter information on line 7 of screen K if a foreign person owned, directly or indirectly, at least 25% of the total voting power of all classes of the corporation’s stock entitled to vote, or the total value of all classes of stock of the corporation. (If there is more than one 25%-or-more foreign owner, complete the fields for the person with the highest percentage of ownership.) Enter the percentage that person owned, the owner’s country of residence, and, if necessary, the number of 5472 forms attached to the return. (The system automatically calculates the number of 5472 forms needed; enter a number in this field only to override the calculated amount.)

Generally, a 25% foreign-owned corporation with a reportable transaction during the tax year must file Form 5472, Information Return of a 25% Foreign Owned U.S. Corporation or a Foreign Corporation Engaged in a U.S. Trade or Business. See Form 5472 for filing instructions and penalties for failure to file.

NOTE
See section 6038A(c)(5) and the related regulations for the constructive ownership rules of section 318 that apply in determining if a corporation is foreign owned.

**NOTE**

If another entity owns 20% or more of the client’s corporation, or owns 50% or more of the corporation’s stock entitled to vote, see “Schedule K, Line 4” on page 16.

**Schedule K, Line 13**

On line 13 of screen **K**, select **Yes** if the corporation’s total receipts (line 1a + lines 4 through 10 on page 1 of Form 1120) are less than $250,000 for the tax year, and its total assets at the end of the tax year are less than $250,000.

If the answer to line 13 is **Yes**, in the lower text box of line 13 enter the total amount of cash distributions and the book value of property distributions (other than cash) made during the tax year. (An entry here overrides the amount calculated from entries on line 5 (Distributions) on the **M2** screen and reflected on page 4, line 13, of the 1120 return.)

**NOTE**

If the answer on line 13 is **Yes**, the corporation is not required to complete Schedule L, M-1, or M-2. To force the software to print these forms, go to the **PRNT** screen and select **Force Schedules L, M-1, and M-2 to print**.

**State-Specific Information**

**Resident State**

The program automatically generates a return for the corporation’s resident state. Use screen **2** to enter company information as it should appear on the state return.

Company information includes the type of return that applies for state purposes (consolidated, composite, controlled group, multi-state), and state-specific dates and numbers for identification.

**NOTE**

The company information fields on screen **2** apply for the resident state only.

**Other States**

Data for other states must be entered manually in state data entry. To access state data entry, select the **States** tab, or enter the two-letter state code in the selector field and press **ENTER**.

To apportion income to multiple states, it is necessary to enter the apportionment factors on the individual state screens.
Contact Information

If certain contact information required for state purposes is different from that entered on screen 1, use screen 2. This screen has fields for the following types of contact information:

- Registered office
- Principal place of business
- “Books in care of”
- General contact information

Screen 2 also has fields for the name, title, e-mail address, ID number, and telephone number of the corporation’s contact person.

Other Information and Overrides

Use screen 1 to enter the following additional information:

**Resident State** — If the corporation has a mailing address in one state but does business in another, select the state in which the corporation does business from the Resident State drop list.

**Drake Codes and Overrides** — Screen 1 includes fields for miscellaneous codes, invoice numbers, and several overrides. See “Listing a Different Firm, Preparer, or ERO on a Return” and “Miscellaneous Codes” in *Drake Software User’s Manual: Tax Year 2010* for more information.

_worksheet outlining these and other adjustment and override fields are accessible through the FAQs (Frequently Asked Questions) screen. For more information, see “Guide to Overrides and Adjustments” on page 27.

Schedule L (Balance Sheet per Books)

Schedule L is required if the corporation’s total receipts for the tax year or its total assets at the end of the year are greater than $250,000.

Flow of Information

Many of the entries made elsewhere (such as inventory information from Schedule A) flow automatically to the generated Schedule L. Depreciable asset information from the 4562 screen and intangible assets and amortization also flow to Schedule L.

Use the corporation’s balance sheet to enter data directly onto Schedule L.

_worksheet outlining these and other adjustment and override fields are accessible through the FAQs (Frequently Asked Questions) screen. For more information, see “Guide to Overrides and Adjustments” on page 27.

See “Importing Trial Balance Information” on page 33 for information on using the trial balance import to enter Schedule L data.
The SCH2 Screen

The SCH2 screen (see Figure 6) is used to provide detailed information required by the IRS for certain lines on Schedule L. The amounts are carried to Form 1120 and printed on an attached statement.

This screen can also be used in place of the actual L screen in Drake. If you use this screen for all applicable lines on Schedule L, you do not need to make any entries on screen L.

**Note**

To access the SCH2 screen from screen L, click an SCH2 Screen link or press CTRL and the number 2. Press Esc to return to screen L.

**Entering Information**

To create a statement for a line using the SCH2 screen, select the desired line from the Line Number drop list and enter descriptions and their corresponding amounts.

![Figure 6: SCH2 screen fields for line number, description, and amounts](image)

Once the information is entered, or if additional descriptions are required for the line, press PAGE DOWN to access a new screen.

**Note**

All line selections and screen descriptions are carried to the next year, and year-end amounts are carried to the beginning-of-year column, when the returns are updated.

**Statements**

The total amounts entered on the SCH2 screen do not show up on the actual L screen in the program. They are, however, printed on the return where needed, with references to the corresponding statements.

The type of statement produced by the program depends on the selected line and the IRS requirements. If a line is required, a statement labeled “STATEMENT” is produced and is e-filed with the return. If a line is not required, a statement sheet (“STMT”) is produced and is NOT e-filed with the return.

Note that an e-fileable “STATEMENT” is referenced in the return.

**SCH2 and Trial Balance Import**

Typically, one or more SCH2 screens are needed for Schedule L items. Data for the SCH2 screens cannot be entered directly into the trial balance worksheet. Although the amounts must be included in the trial balance worksheet for the worksheet to balance, the SCH2 detail screens must be created separately from the worksheet. When the return is produced, Schedule L will reflect both the amounts imported from the
trial balance worksheets (where direct entry was allowed) and the totals of the SCH2 screen amounts.

See “Importing Trial Balance Information” on page 33 for detailed instructions using the trial balance worksheet for SCH2 items and amounts.

**Autobalance**

Autobalance forces Schedule L to balance for both the beginning- and end-of-year amounts. The program adjusts the unappropriated retained earnings amount on Schedule L by the difference between the total assets and the total liabilities and capital before the adjustment. For example, if assets are $1,000 and liabilities and capital are $900, the program increases the unappropriated retained earnings by $100.)

The program makes the adjustments due to differences in the balance sheet. Incorrect data entry could cause these differences but they are usually the result of one of the following issues:

- An asset was deleted from 4562 screen (Depreciation Detail) instead of being indicated as sold.
- Beginning inventory amounts were adjusted on the Schedule A or ending inventory amounts were entered incorrectly.
- Amounts were erroneously deleted or changed from screen L.

To reconcile the differences, it is best to compare the corporation's beginning and ending balance sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn off autobalance.

*Note*  If you are using trial balance import, autobalance must be turned off prior to import. See “Preparing to Use Trial Balance Import” on page 33.

**Schedules M-1 and M-3 (Reconciliation of Income per Books)**

Schedule M-1 is required if the balance sheet’s total assets at the end of the year exceed $250,000 but are less than $10 million. Schedule M-3 is required if the balance sheet’s total assets at the end of the year equal or exceed $10 million.

*Note*  If the corporation is filing Schedule M-3, any entries on the M1 screen (for Schedule M-1) should be deleted.

**Schedule M-1**

Schedule M-1 shows all items of income and expense that are not subject to tax, plus those accounting items that are not income tax items. When required, the corporation must reconcile book income with the taxable income.
Use the **M1** screen schedule to enter book-to-tax difference for Schedule M-1. Book-to-tax differences are classified as permanent or temporary, and as favorable or unfavorable. Examples of both kind of differences are shown in Table 1.

### Table 1: Examples Book-to-Tax Differences for Schedule M-1

<table>
<thead>
<tr>
<th>Difference</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Permanent  | Book or tax items that will never be reported for book or tax purposes     | - Meals & entertainment limitations
|            |                                                                            | - Penalties
|            |                                                                            | - Tax-exempt interest                                                                               |
| Temporary  | Items that will be reported for both tax and book purposes, but not during the same tax year | - Depreciation
|            |                                                                            | - Gains or losses on the sale of depreciated assets                                                  |
| Favorable  | Items that reduce taxable income                                           | - Instances in which tax depreciation amount is greater than book depreciation amount                |
| Unfavorable| Items that increase taxable income                                         | - Disallowed meals & entertainment                                                                   |

**Schedule M-3**

Schedule M-3 is completed using the following screens, all found on the **General** tab of the **Data Entry Menu**:  
- **M3, M31, M32, and M33** — for **Parts I, II, and III** of the Schedule M-3  
- **M3B** — for Schedule B Additional Information for M-3 filers  
- **SCH3** — for subsidiary schedules for Schedule M-3 and Form 8916-A  
- **M3S** — for supplemental statements  
- **8916** — for reconciling of M-3 with taxable income for mixed groups  
- **916A** — for supplemental attachments to the M-3

If the corporation is required to file (or voluntarily files) Schedule M-3, the corporation **must** file Form 1120 and all attachments and schedules, including Schedule M-3.

Certain income and deduction amounts and adjustments flow from Form 1120 to Schedule M-3 and Form 8916A in the program, but all other M-3 data must be entered manually.

If a Schedule M-3 is present in a return, no Schedule M-1 is generated.

**Parts I-III**  
Part I of Schedule M-3 asks certain questions about the corporation’s financial statements and reconciles financial statement worldwide net income (loss) for the corporation (or consolidated financial statement group, if applicable) as reported on Schedule M-3, Part 1, line 4, to net income (loss) per the income statement of the corporation for U.S. taxable income purposes, as reported on Schedule M-3, Part 1, line 11.

Parts II and III reconcile financial statement net income (loss) for the U.S. corporation (or consolidated tax group, if applicable) as reported on Schedule M-3, Part II, line 30 (column d), to taxable income (loss) as reported on Form 1120, page 1, line 28.
The software carries certain items that are readily available, but it does not balance the M-3 automatically. To ensure that the M-3 balances, additional data entry may be required on the M31, M32, and M33 screens.

**Schedule B**

Schedule B is required when an M-3 is present in a return. Use screen M3B for Form 1120 Schedule B, Additional Information for M-3 Filers.

**The SCH3 Screen**

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed information for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 and 8916A screens. For more information on using this type of screen, see “The SCH2 Screen” on page 20.

**Schedule M-2 (Unappropriated Retained Earnings)**

Information from Schedule M-2 Unappropriated Retained Earnings form ties to the Schedule L, line 25 portion of the balance sheet. Increases, distributions, and other decreases to the retained earnings are entered on Schedule M-2. Unappropriated retained earnings refer to corporate income that has not been distributed to shareholders that is available for dividend distribution.

**M-2 Troubleshooting**

The beginning Unappropriated Retained Earnings flows from Schedule L (Balance Sheet), and the Net Income (Loss) per books flows from the completed Schedule M-1 or M-3 on Form 1120. These numbers, combined with amounts entered on the M2 screen, are used to calculate the ending Unappropriated Retained Earnings.

If the computed amount does not match the amount in the completed Schedule L (Balance Sheet), the system produces an EF message that the M-2 is out of balance. Solving this problem can be challenging, since it can have one of several causes:

- The beginning balance sheet entries are inaccurate
- The Beginning of Year unappropriated retained earnings amount (line 25 on screen L) entered on the SCH2 screen for line 24 (Retained earning-Appropriated) is incorrect
- Autobalance is not turned on (See “Autobalance” on page 21.)
- The ending balance sheet entries are inaccurate
- The net income per the tax return is inaccurate
- The reconciling items on Schedule M-1 or M-3 need to be adjusted
- The reconciling items on Schedule M-2 need to be adjusted.

If the items are off by a couple of dollars or less, resolve the problem by entering a reconciling item on the M2 screen:

1. Double-click in a field on the M2 screen to open a detail (CTRL+W) worksheet.
2. Enter an amount and the word “Rounding” as the description.
3. Press Esc. The program returns to the M2 screen.
If the problem is not resolved, it may be necessary to do a detailed comparison between the corporation’s financial records and the completed return information.

**Schedule O (Controlled Group Information)**

Use screens **O** and **OM**, accessible from the first **Other Forms** tab, to fill out Schedule O, Consent Plan and Apportionment Schedule for a Controlled Group. Press PAGE UP and PAGE DOWN to navigate from screen to screen.

**NOTE**

Members of a controlled group are entitled to one $50,000, one $25,000, and one $9,925,000 taxable income bracket amount, in that order.

**AMT Adjustments and Other Items**

Alternative Minimum Tax (AMT) adjustments are limited among the members of a controlled group. These should be entered in the **Other** information fields of the **OM** screen (Figure 7).

![Figure 7: Other information fields for other AMT adjustments](image)

**Types of Controlled Groups**

At the top of screen **O**, mark the box indicating the type of reported controlled group for which Schedule O is reporting. Controlled group types are briefly defined below. See Schedule O instructions for more details.

- **Parent-subsidiary group** — One or more chains of corporations that are connected through stock ownership with a common parent corporation if certain conditions apply.
- **Brother-sister group** — Two or more corporations if the same five or fewer persons who are individuals, estates, or trusts directly or indirectly own stock of each corporation with a certain amount of voting power.
- **Combined group** — Three or more corporations, each of which is part of a parent-subsidiary group or a brother-sister group, and one of which is (1) a common parent corporation included in a group in a parent subsidiary group, or (2) included in a group of corporations in a brother-sister group.
- **Life insurance companies only** — Two or more insurance companies subject to tax under section 801, that are members of one of the previously described groups, are treated as a particular type of controlled group.
Line 5, Apportionment Plan Status

The corporation is required to provide information about the status of the group’s apportionment plan. Select the applicable box on screen O to show the status of the controlled group’s apportionment plan. If adopting a plan or amending the current plan for a prior tax year, at least one year must remain on the statute of limitations for each group member for assessing any resulting deficiency.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. Drake 2010 carries the required adjustments to the appropriate line of the return and to Schedule M-1 or M-3. Manually reducing the expenses/deductions or increasing the income for these credits causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following credits:

- Form 6478, Alcoholic and Cellulosic Biofuel Fuels Credit
- Form 8864, Biodiesel and Renewable Diesel Fuels Credit
- Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts for the following credits:

- Form 5884, Work Opportunity Credit
- Form 6765, Credit for Increasing Research Activities
- Form 8820, Orphan Drug Credit
- Form 8845, Indian Employment Credit
- Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips
- Form 8881, Credit for Small Employer Pension Plan Startup Costs
- Form 8844, Empowerment Zone and Renewal Community Credit
- Form 8941, Credit for Small Employer Health Insurance Premiums

Adjusting Charitable Contributions/NOL

Corporations with a net operating loss (NOL) carryover from any taxable year must apply the special rule of IRC section 170(d)(2)(B) for charitable contributions. The rules are designed to prevent a double tax benefit through interaction of NOL and charitable contribution carryovers. The excess charitable deduction can reduce taxable income only once. Under these rules, a corporation’s charitable contributions carryover (but not the NOL carryover) must be reduced to the extent the charitable contribution deduction, in computing the taxable income of an intervening year, would increase the NOL to a succeeding year.

Limitation on Deduction

The total amount claimed cannot be more than 10% of taxable income (line 30) computed without regard to the following:
• Any deduction for contributions
• The special deductions on line 29b
• The deduction allowed under section 249
• The domestic production activities deduction under section 199
• Any net operating loss (NOL) carryback to the tax year under section 172
• Any capital loss carryback to the tax year under section 1212(a)(1)

To prevent the double benefit from the excess charitable contribution deduction when there is a charitable contribution on the return and an NOL carryover, the program makes the IRC section 170(d)(2)(B) adjustment. In this situation, the charitable contribution carryover amount is reduced on column C of the Contribution Limitation/Carryover worksheet (WK_CNTRB in View mode), and the NOL carryforward is increased on the ATT_NOL worksheet.

Making Changes on the Fly

Use the PRNT screen to override most program defaults.

Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the PRNT screen and select the desired options. Many “on-the-fly” changes override the options established in Setup.

You can force the program to print the following 1120 items on a return:

• Schedule E
• Schedules G (1120-C), L, M-1, and M-2
• Form 4562
• Next-year depreciation listing
• Inactive returns
• PIN for the preparer’s alternative electronic signature

NOTE

Schedule E is required if total receipts (line 1a + lines 4 through 10) are $500,000 or more.

Schedules L, M-1, and M-2 are not required if receipts and total assets (Schedule K, line 13) are less than $250,000.

The PRNT screen can also be used to suppress printing of the following items on a return:

• Form and attachment references (References are printed by default.)
• Form 4626, Alternative Minimum Tax—Corporations

Calculation and Other Options

The following calculation and other options are available:
• **Calculate Form 2220 penalty** — Select this box to have the program calculate the penalty for Form 2220, Underpayment of Estimated Tax by Corporations. (The program retains the rates as of 12/31 of the calendar year. If a corporation has a fiscal year end, the preparer must enter the effective rates manually.)

• **Calculate WK_1120W based on 2010 taxable income** — The WK_1120W is an estimated tax worksheet based on the current tax year taxable income.

• **Calculate Form 4466 (application for quick refund)** — Form 4466, Corporation Application for Quick Refund of Overpayment of Estimated Tax. (A check mark in this box is the only entry needed to generate the form.)

• **Subchapter T Cooperative** — Select this box to have the return treated as a Subchapter T cooperative. When this box is selected, “Subchapter T Cooperative” is printed above the corporation name on page 1 of the return but the return does not become an 1120-C return.

• **Turn off autobalance** — For more information on the autobalance feature in Drake, see “Autobalance” on page 21.

• **Prepare Form 7004 extension based on screen 1 info** — Select this box to prepare a six-month extension based on the information that has already been entered into the return. Note that screen 1 must be completed to prepare an extension.

**NOTE**

To prepare Form 7004 based on information other than (or in addition to) that provided on screen 1, use the 7004, or EXT, screen.

**Overriding Other Setup Options**

The following program defaults can be overridden from the PRNT screen:

• Filing instructions (federal and state)
• Envelope coversheets (corporation, IRS, state, and city)
• Date to print on return
• Due date to print on letter and filing instructions (see note below)
• Amount on Form 1120, page 1, item D (“Total assets”)
• IRS Service Center

**NEW FOR 2010**

A default due date for filing is printed on all letters and filing instructions generated with a return. You can now override the default by entering an alternate due date in the Due date to print on letter and filing instructions field on the PRNT screen.

**Guide to Overrides and Adjustments**

Available in the 1120 package are spreadsheets with information on overrides and adjustments in the business packages. These spreadsheets allow preparers to see what data or calculations are being affected when an entry is made in an override or adjustment field. They can provide a better understanding of how overrides and adjustments work in the software.
To access the worksheets, click FAQ from any Data Entry Menu, and then click the Screen Help button at the top of the FAQ screen. Next, click the link for the desired worksheet and wait for the worksheet to be displayed as a PDF file.

An Internet connection and Adobe Reader are required in order to view the worksheets.

Much of the information contained in the worksheets is also available from the field-level helps within the program. To access a field-level help, click inside a field and press F1, or right-click in a field and select View Help.

**Electronic Filing**

Steps for e-filing Form 1120 are the same as for e-filing Form 1040, with the exception of bankruptcy returns, which must be paper-filed.

**Common Error Codes**

If one or more of the following IRS error reject codes is generated when e-filing an 1120 return, the preparer must contact the IRS for further information. The e-file help desk number is (866) 255-0654.

- **Reject Code 307** — Filer’s TIN and Name Control in the return header must match data in the e-File database unless Form 1120, Item E (3), check box “Name Change” is marked.
- **Reject Code 900** — The return type indicated in the return header must match the return type established with the IRS for the EIN.
- **Reject Code 905** — Electronic Filing Identification Number (EFIN) in the return header must be listed in the e-File database and in accepted status. If you get this reject code, you must update your e-file application to include the 1120 return type.

4 Check the individual and/or business form types you will e-file for:

- [ ] 940
- [ ] 941
- [x] 990
- [x] 1040
- [ ] ETD
- [ ] 1041
- [x] 1065
- [x] 1120
- [ ] 1120 POL
- [ ] State Ack

*Figure 8:* The 1120 box must be marked on Form 8633 in order to e-file Form 1120.

This can be done at the IRS website or by calling the IRS e-file Help Desk at (866) 255-0654.

- **Reject Code 910** — If “Amended Return” or (Superseded for 1120/1120S) check box is not selected, then Taxpayer TIN in the return header must not be the same as a TIN of a previously accepted paper return for the return type and tax period indicated in the tax return.
Special Types of Returns

This section covers 52-53–week year returns and inactive returns. Both types of returns can be e-filed using Drake.

Electing a 52-53–Week Year (Initial Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter data on both screen 1 and the ELEC screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year beginning and Fiscal year ending dates. Use MMDDYYYY format, as shown in the example in Figure 9.
2. Mark the 52-53-week tax year box.

![Figure 9: In this example, the fiscal year begins 12/30/09 and ends 1/1/11 (the Saturday closest to the end of December), giving the entity a 53-week year for 2010.](image)

3. Click the ELEC link to open the Election Options screen (Figure 10).

![Figure 10: Elections for 52-53-week tax years](image)

4. For line 1, select the month in which the 52-53–week year ends for the current fiscal year. (01 = January, 02 = February, etc.)
5. For line 2, select the day of the week the tax year always ends.

An entity that has filed returns in the past must complete only steps 1 and 2 of this process. An entity that has never filed a return before must continue with steps 3 through 6.
6. For line 3, enter the actual date that the tax year ends (the same date entered in the Fiscal year ending field on screen 1).

**NOTE**

Once a 52-53-week year is selected, the entity must use that accounting period every year. To change accounting periods, the entity must submit to the IRS Form 3115, Application for Change in Accounting Method.

In subsequent years, only the 52-53-week tax year check box on screen 1 must be marked; the program automatically updates the dates.

**Inactive Returns**

Entities that are inactive but are still required to file returns may e-file inactive returns in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.
2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on the main form of the return (specifically, on lines 1c and 2). Zeros are displayed where required by the IRS in order for amounts to be properly included in the e-file data.

**IMPORTANT**

All EF messages must be cleared in order to e-file an inactive return.

For detailed instructions on e-filing returns in Drake, see Drake Software User’s Manual: Tax Year 2010.

**Binary Attachments**

Binary, or PDF, files can be attached to certain tax forms. These attachments are generally signature or third-party documents such as a copy of a signed lease or a signed appraisal statement. In some instances, the IRS requires that a document be attached to an e-filed return; in other instances, a document can be attached voluntarily to support or explain an entry in the return. In either case, a PDF must be available to be attached to the return in order to be e-filed with the return.

Attach files through the PDF Attachments screen, accessible from the Electronic Filing section on the General tab of the Data Entry Menu.

**The PDF Attachment Process**

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF file to be attached
2. Informing the program that a PDF file will be sent with the return
3. Attaching the PDF file for e-filing

These steps are described in the following sections.
Creating a PDF File

To create a PDF file:

1. Scan the document to be attached to the return as a PDF.

   Tip
   It's a good idea to use the DDM scanning feature for this step.

2. Save the document to your client’s DDM file, your computer’s desktop, or anywhere you can readily find it.

   Note
   Many types of documents (for instance, documents created in Microsoft Word) can be printed or “saved” as PDF files if you have a PDF printer (such as Adobe Reader) installed.

Adding PDF Files

To indicate in the software that a PDF file will be sent with the return:

1. Go to the PDF screen in data entry.
2. Fill out the columns on the screen. See Table 2 for examples.

   Table 2: PDF Attachment Window Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
   | Reference Source  | Name or number of regulation, publication, or form instruction that makes attachments necessary | - IRS Pub xxx-1.4
   |                   |                                                                             | - Form Instructions for 1120 |
   | Description       | Description of form or document to be attached                              | - Title of house on Oak Street |
   |                   |                                                                             | - Appraisal of Lot 1234      |
   | File name         | Distinctive, easily recognizable file name, followed by “.pdf”             | - TitleHouseOakSt.pdf        |
   |                   |                                                                             | - AppraisalLot1234.pdf       |

3. Exit the PDF screen.

Because you’ve indicated that a PDF file is attached, the program generates an EF message page regarding the attachment when the return is calculated.

Attaching Documents to the Return

To attach a PDF file to a return:

1. From the return, click View. If anything was entered on the PDF screen (see “Adding PDF Files,” previously), there will be three PDF–related items in the View/Print window:
   a. A red MESSAGES alert (see item 1 in Figure 11)
   b. An EF_PDF~ worksheet that lists all items entered on the PDF screen (see item 1 in Figure 11)
   c. An Attach PDF button on the toolbar (item 2 in Figure 11)
2. Click **MESSAGES** file to view EF messages, which provide information on how to attach the required documents to the return.

3. Click the **Attach PDF** button in the toolbar at the top of the window. The **EF PDF Attachments** window displays the information entered on the **PDF Attachments** window in data entry. A red X means the document has not yet been attached; a green check mark indicates an attached document.

4. Click the row of a document to attach.

5. Click **Browse**.

6. Browse to the proper folder, select the PDF file to attach, and click **Open** (or double-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a completed return, the return is ready to be e-filed.

### Printing Generated Documents

In some instances, Drake generates a document that must be attached to the return. For example, if Form 851, Affiliations Schedule, is present in a corporate return, message 0132 is generated when the return is calculated.
Figure 13: EF message regarding Form 851

As shown in Figure 13, the EF message states that attachments are required. You would then need to obtain or complete the statements, scan them into the computer, save them as a PDF file, and attach them to the return.

Importing Trial Balance Information

Drake’s trial balance import feature allows data to be imported into an 1120 return from a trial balance worksheet. The trial balance template and importing function has the following benefits:

• Eliminates the need to duplicate entries
• Reduces data entry errors by automatically importing data to the correct fields
• Allows preparers to merge basic accounting functions with tax preparation.

NOTE

A flow chart of the trial balance importing process is available as an appendix at the end of this manual.

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in Drake 2008 or later. If you haven’t already, create a client file in Drake or update an existing client file from the prior year. Like several other functions of the tax software, this new feature requires Microsoft Excel (version 2000 or later).

In addition, take these actions to ensure the trial balance import works properly:

• **Activate Macros** — The trial balance import function uses macros in Microsoft Excel. Check your Excel settings to ensure that macros are activated and that macro security is set to “medium.” To do so, go to **Tools > Options** in Excel and select the **Security** tab. Click **Macro Security** and select **Medium**, and then click **OK**.

NOTE

In Windows 7 and in Microsoft Vista, click the **Office** button in the upper left and then click the **Excel Options** button at the bottom of the window. Next, select **Trust Center** from the list at left, then click the **Trust Center Settings** button. Select **Macro Settings** from the list on the left, then choose **Disable all macros with notification**. Click **OK**.
• **Disable Autobalance** — When autobalance is disabled, the program is prevented from automatically adjusting the year-end retained earnings or capital amounts, thus allowing you to see any discrepancies in the balance sheet. To disable autobalance, go to the PRNT screen and select Turn off autobalance.

• **Force Schedule L** — By default, the program does not display the balance sheet amounts on the return if the entity does not meet the filing requirement. If this is the case, you must override the default in order to have the amounts shown on Schedule L. To force the Schedule L amounts to be printed, go to the PRNT screen and select the applicable check box.

![Figure 14: Check box for forcing Schedule L](image)

• **Check for Detail Worksheets** — The trial balance import allows only those detail worksheets required by the IRS. Check updated returns for detail (CTRL+W) worksheets that are *not* required. For example, the IRS does not require a detail worksheet for the **Gross receipts or sales** field on screen 3; if a return has a detail worksheet for that field, the trial balance will not be imported correctly into the return. Detail worksheets are indicated by red shading, as shown in Figure 15.

![Figure 15: Example of an “unnecessary” detail worksheet](image)

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” on page 36 for more information on using detail worksheets in the trial balance.

### Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered into Drake’s specially designed trial balance template. Once this information is entered and saved, it can be imported into the return.

**Opening a Template**

The first step in preparing financial data for importing is to open a trial balance template for the return and enter the financial data.

To open a trial balance template for a return:
1. Open the return to the **Data Entry Menu**.

2. Click **Import > Trial Balance Import** in the menu toolbar. The preliminary **Trial Balance Import** dialog box is opened.

3. Click **Create New** or **Open Existing**. If opening an existing file, click **Open** after selecting the correct file.

4. If a **Security Warning** box appears, click **Enable Macros**.

**NOTE**

In Windows 7 and Microsoft Vista, you may see a **Security Warning** message with an **Options** button. Click **Options** to open the **Security Options** dialog box, then select **Enable this content**. Click **OK**.

The trial balance template is displayed in Microsoft Excel.

Whenever a new template is opened, the tax software assigns it a default file location and name. Trial balance templates are saved in the TB folder of your Drake10 software. The file name consists of the client name as entered in Drake, plus “TB” for “trial balance,” plus the “.xls” extension assigned to all Excel files, as shown in Figure 16.

To change the name of a file in Excel, select **File > Save As** and assign the new name.

**NOTE**

If saving a trial balance to a different location, make of note of where you’re storing it. The program automatically looks in the default directory.

The trial balance template consists of three title rows and six columns. The **Entity Name** and **Year End** title rows can be edited; double-click a row to change the title. Columns are described in Table 3.

**Table 3: Trial Balance Template Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Title</td>
<td>Title of account</td>
</tr>
<tr>
<td>Debit/Credit</td>
<td>Debit and credit amounts</td>
</tr>
<tr>
<td>Import to</td>
<td>Screen and line in Drake to which the debit or credit amount is imported</td>
</tr>
<tr>
<td>Form, Page, Sch, and/or line</td>
<td>Location of the amount on the printed return</td>
</tr>
<tr>
<td>Other information</td>
<td>Additional details for preparers; see “Details for Preparers” on page 39.</td>
</tr>
</tbody>
</table>
Displayed at the bottom of the trial balance worksheet are the calculated amount for Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the balance sheet is out of balance and, if applicable, the out-of-balance amount (Figure 17; see also Figure 20 on page 37).

Figure 17: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to assemble financial data for importing into data entry.

### Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are zero ($0). All data must be entered manually into the template.

**NOTE**

Some data cannot be imported from the trial balance and must be entered directly into the data entry fields within the program. For more on these categories of data, see “Special Conditions” on page 39.

**Direct Entry**

Most cells in the trial balance worksheet are view-only. In a new template, editable debit and credit cells are indicated by a dollar amount ($0).

**Detail Worksheets**

Some cells require more detail than can be entered on a single line. These cells are indicated by buttons. (Buttons do not work if macros are disabled; see “Opening a Template” on page 34.)

Click a worksheet button to open a worksheet in a new tab. Figure 19 shows an example of the “Other Income” worksheet.
Drake Software User’s Manual

Importing Trial Balance Information

Statement Required - Other Income

Form 1120, page 1, line 10

<table>
<thead>
<tr>
<th>Line Description</th>
<th>Amount</th>
<th>Import to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Amount of credit for tax on fuels (Form 4135)</td>
<td>$0</td>
<td>INC, line 1</td>
</tr>
<tr>
<td>2 Interest income on receivables</td>
<td>$0</td>
<td>INC, line 2</td>
</tr>
<tr>
<td>3 Ordinary income from partnerships</td>
<td>$0</td>
<td>Partnership Income Detail</td>
</tr>
<tr>
<td>4 Recoveries of bad debts deducted in earlier years</td>
<td>$0</td>
<td>INC, line 4</td>
</tr>
<tr>
<td>5 Section 491 adjustments</td>
<td>$0</td>
<td>INC, line 5</td>
</tr>
<tr>
<td>6 State tax refund (cash basis)</td>
<td>$0</td>
<td>INC, line 6</td>
</tr>
<tr>
<td>7 Taxable income from insurance proceeds</td>
<td>$0</td>
<td>INC, line 7</td>
</tr>
<tr>
<td>8 Other</td>
<td>$0</td>
<td>Other Income Detail</td>
</tr>
<tr>
<td>Total other income</td>
<td>$0</td>
<td></td>
</tr>
</tbody>
</table>

Figure 19: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the Corp TB tab (labeled “1” in Figure 19), or click the Return button above the worksheet tabs (labeled “2” in Figure 19). Note that a detail tab (the “Other Income” tab in Figure 19) might include one or more detail worksheets (labeled “3” in Figure 19).

**NOTE**

Do not create detail worksheets in data entry if the trial balance worksheet does not provide an equivalent detail worksheet. Otherwise, the trial balance will not be imported correctly.

**Totals**

Totals are displayed at the bottom of each worksheet. If credit and debit columns are out of balance, the worksheet highlights the out-of-balance amount (Figure 20).

Figure 20: Out-of-balance amount is highlighted if columns are out of balance.

In addition to credit and debit totals, the main trial balance worksheet shows the net income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjustments are made in the software.

**NOTE**

The data cannot be imported if the worksheet is out of balance.
Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. To re-name a file when saving, select File > Save As. For more information on file names in the trial balance program, see “Naming Convention” on page 35.

Importing Data into a Return

Not all trial balance data can be imported directly into a return. For information on program limitations, see “Special Conditions” on page 39.

Once a trial balance worksheet has been set up for a client in Drake, the trial balance information can be imported into the program and calculated into the return.

If you are already in the Trial Balance Import tool for the selected return, go to the Trial Balance Import window in Drake and start at Step 3 of the following procedure.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.
2. Click Import > Trial Balance Import from the menu toolbar. The preliminary Trial Balance Import dialog box is opened.
3. Click Next.
4. Enter or select the trial balance file to be imported. Use the Browse feature if necessary. By default, each trial balance file is an Excel (.xls) file showing the client name and ending in “TB” for trial balance, as shown in the example in Figure 21. (See “Naming Convention” on page 35.)

Figure 21: Selected file to import

5. Select the Trial Balance Import Options. (See “Additional Import Options” following this procedure.)
6. Click Next and wait for the import to be completed.
7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all selected data from the trial balance worksheet has been imported into the return. This can be seen both in the data entry screens and on the generated return.

Additional Import Options

The program can import the following additional information when importing the trial balance data: (Select the items to import or click Select All.)

- Buildings & other depreciable assets
- Accumulated depreciation
- Goodwill & other intangible assets
- Land

NOTE

Not all trial balance data can be imported directly into a return. For information on program limitations, see “Special Conditions” on page 39.

NOTE

If you are already in the Trial Balance Import tool for the selected return, go to the Trial Balance Import window in Drake and start at Step 3 of the following procedure.
Accumulated amortization

**Special Conditions**

Some trial balance items cannot be entered into the trial balance worksheet and must be typed directly into Drake data entry. Other items should be entered into the worksheet for balance purposes but are not carried to data entry; these must be entered separately and the calculated results compared to the trial balance worksheet.

**Details for Preparers**

Most trial balance items go directly to the location indicated in the program and on the return. For example, the amounts shown in Figure 22 go to Schedule L, line 1, column d in the program and are shown on page 5, line 1, column d of the 1065 return.

<table>
<thead>
<tr>
<th>Debit</th>
<th>Credit</th>
<th>Import to:</th>
<th>Reported on:</th>
</tr>
</thead>
<tbody>
<tr>
<td>$420,050</td>
<td></td>
<td>L, line 1, col d</td>
<td>1065, page 5, line 1, col d</td>
</tr>
<tr>
<td>$2</td>
<td></td>
<td>L, line 2a, col c</td>
<td>1065, page 5, line 2a, col c</td>
</tr>
</tbody>
</table>

**Figure 22**: Indication of where an amount will go in Drake and on the return

Not all figures can be imported directly, however, and some amounts are optional. Drake has provided an “Other Information” column in the trial balance worksheet to indicate special conditions and additional information regarding certain rows. Table 4 describes the most common notes in this column.

**Table 4**: “Other Information” Column Notes

<table>
<thead>
<tr>
<th>Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>not included in totals</td>
<td>The amount is required for importing purposes only but is not included in the totals shown on the trial balance.</td>
</tr>
<tr>
<td>does not import</td>
<td>Information cannot be imported and must be entered on the appropriate screen in Drake. Screen is specified in column to the left of “Other Information.”</td>
</tr>
<tr>
<td>optional</td>
<td>Amount is optional; not required for import, but could require direct entry in the software.</td>
</tr>
<tr>
<td>enter as negative number</td>
<td>Some deficits must be entered as negative numbers.</td>
</tr>
<tr>
<td>import includes the calculated change in inventory</td>
<td>Used for “total purchases;” when calculating cost of goods sold (COGS) in the return, the program takes the change in inventory into account for the Schedule A calculation.</td>
</tr>
<tr>
<td>[Form or Schedule] may be required</td>
<td>Non-financial information (such as names of officers for a Schedule E) must be completed in Drake, in addition to the financial data entered in the worksheet.</td>
</tr>
</tbody>
</table>

All “does not import” notes are accompanied by further instructions in the column to the left of the “Other Information” column, as shown in Figure 23.
**SCH2 Detail**  Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is required for an item marked “does not import” on the trial balance.

**Figure 23:** SCH2 screen required for “does not import” items

To complete an SCH2 detail screen for the return:

1. Open the SCH2 screen for the return.
2. Select the line number from the SCH2 drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, the Schedule L of the return reflects both the amounts imported from the trial balance worksheet and the totals of the amounts entered on the SCH2 screen.

Depreciation  On an 1120 return, total depreciation consists of COGS depreciation, which is reported on Schedule A, and any remaining depreciation, which is reported on page 1 of the return. For trial balance purposes, enter depreciation amounts directly into the appropriate fields on the trial balance worksheet.

When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Schedule A on the return, and the rental depreciation expense amounts flow directly to the appropriate lines of the **8825** and **RENT** screens, as applicable. Because the remaining depreciation can comprise any number of assets, the amount entered on the trial balance does not flow to the return. To ensure that each component of the total remaining depreciation is calculated into the return, each asset must be entered on the applicable depreciation screens in data entry.

Entering the remainder of the depreciation on the trial balance worksheet helps ensure that the balance sheet balances and provides a way to check that the amount on line 1 of Schedule M-1 is correct. Compare the calculated line 1 at the bottom of the trial balance to the equivalent line on Schedule M-1 of the calculated return. If the depreciation amounts match but the line 1 amounts differ, an M-1 adjustment could be required.

---

*NOTE:* Entering the remainder of the depreciation on the trial balance worksheet helps ensure that the balance sheet balances and provides a way to check that the amount on line 1 of Schedule M-1 is correct. Compare the calculated line 1 at the bottom of the trial balance to the equivalent line on Schedule M-1 of the calculated return. If the depreciation amounts match but the line 1 amounts differ, an M-1 adjustment could be required.
Appendix: Trial Balance Import

The trial balance import allows data to be imported into a corporate tax return from a trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the following benefits:

- Eliminates the need to duplicate entries
- Eliminates data entry errors by automatically importing data to the correct fields
- Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
Trial Balance Import: General Process

Prepare to use Trial Balance Import
- Enable Excel macros
- Disable autobalance
- Force Schedule L
- Delete unnecessary detail worksheets

Populate Trial Balance Template (Import > Trial Balance Import)
- direct entry data (cells with $0)
- applicable detail worksheets
- totals for:
  - depreciation
  - Schedule L
  - rentals (1120S & 1065 only)

Populate Data Entry
Enter any trial balance data that cannot be imported via Trial Balance Import
- Screen SCH2 for Schedule L items
- Screen 4562 for individual assets (depreciation)

Compare M-1, line 1: Does trial balance match Schedule M-1, line 1?
- YES
  - 1120 return?
    - YES
      - Go to data entry an enter individual rentals on 8825 or RENT screens as applicable
    - NO
      - Delete imported 8825 and RENT screens
  - NO
    - Did data import correctly?
      - YES
        - Make M-1 adjustment
      - NO
        - Make corrections in TB worksheet

Is an M-1 adjustment necessary?
- YES
  - Adjust amounts elsewhere in data entry
- NO
  - Make M-1 adjustment

Process complete!
Index

A
address
  change of 5
  e-mail 19
  entering on Form 1120 4
adjustment fields 27
adjustments and credits 25
advertising expenses 10
affiliated groups 16
alternative minimum tax (AMT) 24
amended returns 2, 15
amortization 11, 19
apportionment
  plan status 25
  to multiple states 18
attachments
  binary 30–33
  PDF, see PDF files
auto-balance 21, 27

B
bad debts 7, 9
bankruptcy 28
book-to-tax difference (Schedule M-1) 21, 22
brother-sister group 24

C
calendar years 4
capital gains and losses 7
carryover of NOLs 11, 25
change of name or address 5
charitable contributions 9, 25
codes
  error/reject 28
  miscellaneous (screen 1) 19
  state 18
combined group 24
compensation of officers 8
consolidated returns 6
contact information (for state returns) 19
contributions, charitable 9, 25
controlled groups 11, 24
converting to 1120 3
cost of goods sold, see Schedule A (Cost of Goods Sold)
coversheets 27
credit for tax on fuels 7
credits and adjustments 25
Ctrl+W (detail) worksheets 6, 11, 34

D
data entry
  FAQ screen 28
  trial balance import 36
debts, bad 9
deductions and income 5–11
depletion 10
depreciation
  and auto-balance errors 21
  expense 10
  for cost of goods sold (Schedule A) 6
  installment sales and like-kind exchanges 1
  on short-year returns 5
  trial balance (business returns only) 40
detail (Ctrl+W) worksheets 6, 11, 34
direct debit of balance due 13–14
domestic production activities deduction 10

e-filing
  new features in Drake 28
  PDF documents 30–33
electronic
  funds withdrawal (direct debit) 13
  signatures (PIN) 14
entertainment and meals 11
evelope coversheets 27
error codes 28
estimated tax worksheet 27
estimates 12, 27
extensions 14, 27

F
filing instructions 27
final returns
  indicating in the program 5
  updating 3
fiscal year returns 4
foreign ownership 2, 17
Form 1120-C (U.S. Income Tax Return for Cooperative
  Associations) 1, 3
Form 1120-H (U.S. Income Tax Return for Homeowners
  Associations) 3
Form 2220 (Underpayment of Estimated Tax By Corporations) 12, 27
Form 4466 (Corporation Application for Quick Refund of Overpayment of Estimated Tax) 12, 27
Form 4797 (Sales of Business Property) 7
Form 5884 (Work Opportunity Credit) 25
Form 6252 (Installment Sale Income) 1, 6
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit) 7, 25
Form 6765 (Credit for Increasing Research Activities) 25
Form 7004 (Application for Automatic Extension of Time to File) 14, 27
Form 8027 (Employer’s Annual Information Return of Tip Income & Allocated Tips) 1
Form 8050 (Direct Deposit of Corporate Tax Refund) 12
Form 8820 (Orphan Drug Credit) 25
Form 8844 (Empowerment Zone and Renewal Community Credit) 25
Form 8845 (Indian Employment Credit) 25
Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips) 9, 25
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit) 7, 25
Form 8873 (Extraterritorial Income Exclusion) 11
Form 8881 (Credit for Small Employer Pension Plan Start-up Costs) 25
Form 8903 (Domestic Production Activities Deduction) 10
Form 8912 (Credit to Holders of Tax Credit Bonds) 25
Form 8941 (Credit for Small Employer Health Insurance Premiums) 25
Form 8941 (Credit for Small Employer Health-Insurance Premiums) 11

G

gains and losses 7
gross receipts 5

H

header information 4

I

importing trial balance 33–40
income and deductions 5–11
installment sales 1
instructions for filing 27
insurance proceeds, income from 7
interest
    expense 9
    income 6, 7
inventory 5

L

life insurance companies 24
like-kind exchanges 1
limitations
    meals and entertainment 11
    on NOL deductions 25

M

M-2 out of balance, troubleshooting 23
maintenance costs 8
meals and entertainment 11

N

net operating losses (NOL) 11, 25
new features in Drake 1
next-year depreciation listing 26

O

officer compensation 8
ordinary gains and losses 7
other income (loss) 7
out-of-balance M-2, troubleshooting 23
overrides 27
ownership
    foreign 17
    of stock 16–18
    percentages 8

P

parent-subsidiary group 16, 24
partnership income 7
PDF documents, e-filing 30–33
percentage, stock and ownership 8
PIN (electronic) signatures 14
printing
    statements for Schedule L 20
    suppressing/forcing 26
prior-year returns, updating 3

R

receipts 5
references to forms and worksheets 26
refunds
    direct deposit of 12
    state tax 7
reject codes 28
rent paid on business property 9
rental & royalty income 7
repair costs 8
resident state 19
returns
  consolidated 6
  converting from another type 3
  fiscal and calendar year 4
  tax-exempt organizations (990) 30–33
  updating 3

S
salaries 8
SCH2 screen (for Schedule L) 20
Schedule A (Cost of Goods Sold) 5–6, 21
Schedule B (Additional Information for M-3 Filers) 23
Schedule C (Dividends & Special Deductions) 6
Schedule D (Capital Gains and Losses and Built-In Gains)
  bad debts 9
Schedule E (Compensation of Officers) 8, 26
Schedule G (Information on Certain Persons Owning the
  Corporation’s Voting Stock) 26
Schedule G (Schedule G (Information on Certain Persons
  Owning the Corporation’s Voting Stock)) 2, 17
Schedule L (Balance Sheet per Books) 19–21, 26
Schedule M-1 (Reconciliation of Books with Return) 21,
  26
Schedule M-2 (Unappropriated Returned Earnings) 23, 26
Schedule M-3 (Reconciliation of Books with Return) 22
Schedule O (Consent Plan & Apportionment Schedule for
  a Controlled Group) 24
section
  1245 property 1
  1250 property 1
  263A costs 6
  481 7
short-year returns 4
signatures, electronic (PIN) 14
signing the return 14
state
  codes 18
  tax refunds 7
stock ownership 16–18
subchapter T cooperatives 27

T
tax
  alternative minimum (AMT) 24
  and payments 11
  -exempt interest 6
  on fuels (credit for) 7
  -to-book difference 21
  years (fiscal vs calendar) 4
taxes and licenses 9
trial balance import 6, 19, 20, 33–40
troubleshooting the M-2 23

U
underpayment of estimated tax 12
updating a prior-year return 3

V
Vista (Windows operating system) 33
vouchers 12

W
wages 8